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SAFETY INFORMATION

This manual provides general and specific maintenance procedures essential for reliable engine operation
and your safety. Since many variations in procedures, tools, and service parts are involved, advice for all
possible safety conditions and hazards cannot be stated.

Read safety instructions before doing any service and test procedures for the engine or vehicle. See related
application manuals for more information.

Obey Safety Instructions, Warnings, Cautions, and Notes in this manual. Not following Warnings, Cautions,
and Notes can lead to injury, death, or damage to the engine or vehicle.

Safety Terminology

Terms are used to stress your safety and safe operation of the engine: Warning, Caution, and Note

Warning: A warning describes actions necessary to prevent or eliminate conditions, hazards, and unsafe
practices that can cause personal injury.

Caution: A caution describes actions necessary to prevent or eliminate conditions that can cause damage to
the engine or vehicle.

Note: A note describes actions necessary for correct, efficient operation.

Work Area

» Keep work area clean, dry, and organized.

» Keep tools and parts off the floor.

* Make sure the work area is ventilated and well lit.

« Make sure a First Aid Kit is available.

Protective Measures

»  Wear protective safety glasses and shoes.

*  Wear correct hearing protection.

*  Wear cotton work clothing.

*  Wear sleeved, heat protective gloves.

* Do not wear rings, watches, or other jewelry.

* Restrain long hair.

Vehicle

»  Shift transmission to neutral, set parking brake, and block wheels before doing diagnostic or service
procedures.

* Clear the area before starting the engine.




Safety Equipment
* Use correct lifting devices.

¢« Use wheel chocks and stands.

Engine

» The engine should be operated or serviced only by qualified individuals.

* Provide necessary ventilation when operating engine in a closed area.

+ Keep combustible material away from engine exhaust system and exhaust manifolds.
» Install all shields, guards, and access covers before operating engine.

» Do not run engine with unprotected air inlets or exhaust openings. If unavoidable for service reasons, put
protective screens over all openings before servicing engine.

»  Shut engine off and relieve all pressure in the system before removing panels, housing covers, and caps.

» If an engine is not safe to operate, tag the engine and ignition key.

Fire Prevention
* Make sure charged fire extinguishers are in the work area.
NOTE - Check the classification of each fire extinguisher to make sure that the following fire types can
be extinguished:
1. Type A — Wood, paper, textiles, and rubbish
2. Type B — Flammabile liquids
3. Type C — Electrical equipment

Batteries

» Always disconnect the main negative battery cable first.
» Always connect the main negative battery cable last.

* Avoid leaning over batteries.

*  Protect your eyes.

* Do not expose batteries to flames or sparks.

* Do not smoke in workplace.
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NAVISTAR® ENGINE DIAGNOSTICS (NED)

NOTE - This section contains a brief overview of Navistar Engine Diagnostics software, and was
current at the time of publishing. Due to the automatic updating function in Navistar Engine Diagnostics
software, screens and functions may differ from this manual.

INTRODUCTION

Navistar® Engine Diagnostics is a diagnostic and programming service tool for Navistar® Engines. A
fully-featured PC application, Navistar Engine Diagnostics is designed to meet the wide range of diagnostic
challenges when servicing a mixed truck fleet. Coverage includes all J-1939 International electronic engine
systems, allowing you to run special tests, change parameters and view and graph engine data. This is
the top-of-the-line tool for dealers and fleets. The application updates periodically, enabling you to have
the most up-to-date coverage.

NOTE - To diagnose specific electronic control system failures, always refer to the diagnostic manual
for the system being serviced.

NOTE - NED cannot be used to program blank ECMs or update ECM calibrations.

Basic Features

* Read and clear diagnostic fault codes
* View signals and parameters

*  Print trip and vehicle reports

Advanced Features

Diagnostics Tests:

+ KOEO - Key On Engine Off

+ KOER - Key On Engine Running

+  KOEO - Injector Buzz Test

*  KOER - Injector Contribution Test

*  Cylinder Cutout Test (EPA 04’ and newer)
* Injector Disable Tests (EPA 04' and newer)

Display and change configurable parameters:

* Crank Inhibit

« Fan Control

* Idle Shutdown Timer

*  Warm-up Device

* Warning and Protection System
* Hydraulic Pressure Governor

+ PTO Control

+ Radiator Shutter
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*  Vehicle Speed Limit
* Vehicle Retarder
* Two Speed Axle

e Traction Control

ACRONYMS

Following is a list of acronyms and their meanings used in this document:

DPF

Diesel Particulate Filter
DTC

Diagnostic Trouble Code
ECM

Electronic Control Module
ESN

Engine Serial Number
EST

Electronic Service Tool
FMI

Failure Mode Indicator
SPN

Suspect Parameter Number
KOEO

Key On Engine Off
KEOR

Key On Engine Running
MIN

Minimum
MAX

Maximum
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GETTING STARTED
SYSTEM REQUIREMENTS

Minimum Requirements

* 1 GHz Intel Core 2 Duo, AMD Athlon X2 or better

*  Windows 2000° or greater

+  2GB (32-bit) or 4GB (64-bit) of RAM

* 300 MB of free hard disk space

* High speed Internet connection

* 11024 x 768 pixel (or better) display

*  One or more RP1210A compatible communication devices with SAE J1708 and/or SAE J1939 support
(See Diagnostic Interface Cable Information, page 14)

Improved system performance will occur with the installation of increased RAM

Communication Link Drivers

+ Nauvistar Engine Diagnostics uses standard RP1210A drivers for communication. The drivers are specific
to the communications device and are not installed with Navistar Engine Diagnostics.
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INSTALLING THE NAVISTAR ENGINE DIAGNOSTICS (NED) SOFTWARE
It is strongly recommended that all Terminate and Stay Resident (TSR) programs like the Quicktime® program,
CD player programs, or Pocket PC programs be terminated prior to loading or starting the Navistar Engine

Diagnostics software. These programs interfere with the efficient operation of the Navistar Engine Diagnostics
program.

To install the Navistar Engine Diagnostics software:
1. Prior to installation, a Navistar Engine Diagnostics product key must be obtained for each computer on
which the software is to be installed. Product keys expire after a year and must reactivated to allow

access to the program.

2. Using the web browser of your choice, navigate to the Navistar Engine Diagnostics page on Navistar’s
service software site:

http://www.navistarservicesoftware.com/index.php/navistar-engine-diagnostics/
3. Select the DOWNLOAD button to download the Navistar Engine Diagnostics software.

4. When the file has finished downloading, run it (Navistar Engine Diagnostics Setup.exe) to begin
installation. The first page of the Setup Wizard appears.

ENavistar Engine Diagnostics Setup o | ® =]

Welcome to the Navistar Engine
Diagnostics Setup Wizard

This wizard will quide you through the installation of Navistar
Engine Diagnostics.

Itis recommended that you dose all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Next to continue.

[ Next > ][ Cancel ]

0000414030
Figure 1 Setup Wizard: Welcome

5. Click Next.
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(=
5 Navistar Engine Diagnostics Setup o & =
License Agreement ———
Please review the license terms before installing Navistar Engine Diagnostics. NED

Press Page Down to see the rest of the agreement.

IINavistar Engine Diagnostics is licensed under the following agreement |_—]
and the following agreement only.

NAVISTAR ENGINE DIAGNOSTICS SOFTWARE LICENSE
AGREEMENT

TATT A TN AT STCTTRNN L4 AT TITTTSS A SATATOTOR LTOA T SN A TMTITY Y Y YT

If you accept the terms of the agreement, dick I Agree to continue. You must accept the
agreement to install Navistar Engine Diagnostics.

Mullsoft Install System v2.46

[ <Back | 1agee | [ concel |

0000414028

Figure 2 Setup Wizard: License Agreement

6. Read through the License Agreement. When finished, click | Agree to proceed with installation.
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When installation is complete, the final page of the wizard is displayed.

{5 Navistar Engine Diagnostics Setup o] ® | =

Completing the Navistar Engine
Diagnostics Setup Wizard

Navistar Engine Diagnostics has been installed on your
computer.

Click Finish to dose this wizard.

[¥]Run Navistar Engine Diagnostics

< Back Finish Cance

(o]

0000414023
Figure 3 Setup Wizard: Finish
7. Ensure that the RUN NAVISTAR ENGINE DIAGNOSTICS box is checked.

8. Click FINISH to launch the program.
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The first time Navistar Engine Diagnostics is installed on a specific computer, the user is prompted to
enter their product key.

Registration (23]

Code: 813
Please enter your Navistar Engine Diagnostic product key.

If you do not have a product key, please visit the Navistar Engine Diagnostic support page for assistance.
http: /fwww.navistarservicesoftware.com/index.php/navistar-engine-diagnostics/

OK H Cancel ]

0000414029

Figure 4 Product Key Entry
9. Enter the product key obtained for this computer and then click OK.

» If the key was not entered correctly (or there is some other problem), an error message will be
displayed. Refer to Installation Error Messages (page 11) for more information. Resolve the issue
indicated before proceeding.

+ If the key was entered correctly, the following window is displayed. Proceed to Step 11.

0000410435
Figure 5 Existing User Prompt

10. If you already have a Navistar-issued username and password for applications such as DLB, NavKal™
or Navistar Engine Diagnostics, click Yes and proceed to Step 15.

If you DO NOT already have a Navistar issued username and password, click No and proceed to Step 12.
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' A
|%) Registration u

E-mail*

Prefix

First Name*

Middle Initial

Last Name™®

Suffix

Company Name™

Street Address 1%
Street Address 2

City*

State®

ZIP Code™®

Country® UNITED STATES v
Phone Number* |( ) -

*Required fields

[ ok [ cancel |

0000410437
Figure 6 New User Registration

11. The Registration window appears. Fill in the information in this window. Required fields are indicated
by an asterisk (*).

12. Click OK.
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Once registration is completed successfully, the following message is displayed:

Login Information o]

@ Code: 818
‘W Your Username has been successfully created.

Your Username and login information have been sent to the e-mail address you provided when registering this product.
If you do not receive your Username and login email, please visit the Navistar Engine Diagnostic support page for assistance.
http://www.navistarservicesoftware.com/index.php/navistar-engine-diagnostics/

NOTE: You must update your password at the link provided in the e-mail before logging into this application.

0000414103
Figure 7 Username Successfully Created

13. An email will be sent to the address provided on the registration form. Follow the instructions provided in
this email to complete the registration process. When finished, click OK in the window shown above.

NOTE - You MUST change your password by following the instructions provided in the email before
proceeding. The default password cannot be used to log into the application.

14. The User Authentication window appears. Enter your username and password and click OK.

r@j User Authentication M
Server evalueb.internationaldelivers.com is requesting authentication
Username: |
Password:

Lok J[ concel ]
" >

0000410461
Figure 8 User Authentication Window

Once you are logged in for the first time, the software will start and begin to update itself.
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NOTE - The Navistar Engine Diagnostics program will not function until the user has successfully
logged in at least once while connected to the network. The user may need to consult with the technical
computer support staff if the Navistar Engine Diagnostics program cannot connect to the Navistar
site. Error messages will be generated if connection to Navistar fails. Your Internet firewalls must be
configured to allow two-way communication to the following Navistar host names:

*  d2mutuy95x2dyc.cloudfront.net

¢ evalueb.internationaldelivers.com

Be aware that the underlying IP addresses for these hosts are subject to change and may vary by region.
When possible, grant access by host name rather than IP address.

10
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Installation Error Messages

The error messages that may appear during the installation process typically contain explanatory text to help
in troubleshooting. Some sample messages are shown in the table below. in some cases, the table also
includes additional troubleshooting information. For the more information on resolving these messages, please
visit the Navistar Service Software support website:

http://www.navistarservicesoftware.com

NOTE - Before attempting to register the software with a product key, please ensure that you have an
active User ID with a password that has not expired.

Code | Text

800 | The product key provided is terminated. Please visit the support page for assistance.

801 The product key provided does not match the software that you are attempting to activate. Please
re-enter the product key to verify or visit the Navistar Engine Diagnostics support page for assistance.

802 | Your product key has expired. Please visit the support page for assistance.

803 | You've exceeded the number of registrations allowed for this product. Please visit the Navistar
Engine Diagnostics support page for assistance.

804 | An unknown error has occurred. Please visit the support page for assistance.

805 | Application unsupported. Please visit the support page for assistance.

806 | The prior product key provided is terminated. Please visit the support page for assistance.

807 | The product key provided was not found. Please re-enter the product key to verify or visit the
support page for assistance.

808 | An error has occurred while attempting to register the software. Please visit the support page
for assistance.

809 | We're sorry, we can’t connect to the server right now. Please check your connection and try again or
visit the support page for assistance.

810 | An Internet connection to the Navistar Engine Diagnostics server could not be established; press
‘OK’ to continue in offline mode. Your license will be verified each time you log into the system. You
can keep accessing Navistar Engine Diagnostics offline for 30 remaining days. If a connection to the
Navistar Engine Diagnostics Server cannot be established by then, your product will stop working.
Verify that the following Navistar hosts are not blocked by a firewall or a web filter:

+ evalueb.internationaldelivers.com
e d2mutuy95x2dyc.cloudfront.net
811 An Internet connection to the server could not be established, you must resolve this issue before

the application can be used.

This error occurs when the license key has expired due to being offline for 30 days or more.

1
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Code | Text

812 | An Internet connection to the server could not be established, you must resolve this issue before
the application can be used.

On some computers, Navistar Engine Diagnostics has to be run in administrator mode. Follow
these steps:

1. On the Windows desktop, right-click the Navistar Engine Diagnostics icon.
2. In the right-click menu, select OPEN FILE LOCATION.
3. Right-click NAVISTAR ENGINE DIAGNOSTICS.EXE.

4. Select RUN AS ADMIN.

813 | Please enter your product key. If you do not have a product key, please visit the support page
for assistance.

The entered product key was not correct. Be sure to include the entire key. (It should be 19
characters total, not including dashes.)

814 | You have already activated your maximum number of Usernames permitted by your license.

815 | A server side error has occurred and is being examined. Please visit the support page for assistance.

816 | The provided key is a renewal key. Please re-enter a previous product key to continue or visit the
support page for assistance.

Renewal keys allow the license granted by a full key to the software to be extended past its original
expiration date. They cannot be used by themselves (without a full product key). Enter the full
product key whose expiration date is to be extended.

817 | The Username or Password that you entered was incorrect. Please try again or visit the support
page for assistance.

12
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LAUNCHING NAVISTAR ENGINE DIAGNOSTICS
To Launch Navistar Engine Diagnostics:

1. Start the application. There are two ways to do this:

* Double click the Navistar Engine Diagnostics icon on the Windows desktop.

In the Windows Start Menu, select PROGRAMS > > NAVISTAR ENGINE DIAGNOSTICS > NAVISTAR
ENGINE DIAGNOSTICS.

N
NED

0000414147

Figure 9 Navistar Engine Diagnostics Icon

2. The User Authentication window appears. Enter your username and password and click OK.

7~

<
| %] User Authentication ﬂ

Server evalueb.internationaldelivers.com is requesting authentication

Username: |

Password:

Lo ][ concel ]

>
0000410461

Figure 10 User Authentication Window

13
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VEHICLE CONNECTION
DIAGNOSTIC INTERFACE CABLE INFORMATION

The following communication adapters have been verified with all Navistar Engine Diagnostics software:
* Dearborn Group Technologies — DPA 4 and DPA 4+

http://www.dgtech.com/products/diagnostic_truck_tools.html

* Nexiq Technologies — USB Link

http://www.nexig.com/catalog/ product_detail.asp?GID=6&=85

* Noregon Systems, Inc. — DLA, DLA USB

http://www.noregon.com/

Other RP1210A compliant interface devices may work with Navistar Engine Diagnostics.
NOTE - IC3 and IC4 USB cables are not reliable when connected to 2007 and newer Navistar® vehicles.

Please refer to each manufacturer’s website for further information.

14
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CONNECTING NAVISTAR ENGINE DIAGNOSTICS

1.

2.

Turn ignition switch to ON. Do not start engine.
Using interface cable, connect Electronic Service Tool (EST) to vehicle’s diagnostic connector.
Start Navistar Engine Diagnostics software.

If this is the first time a particular interface cable is used with Navistar Engine Diagnostics, it is necessary
to manually select the cable type. Refer to (See Manually Selecting the Interface Cable, page 16)

-&-

0000414146

Figure 11 ECM Connnected Icon

The software should now automatically connect to the ECM. If successful, the, active signals will populate
the startup screen, and the ECM Connected icon will appear in the lower right corner of the window,
indicating that the ECM is connected.

4 »

0000414149

Figure 12 ECM Disconnected Icon

If the software is unable to connect to the ECM, signals and vehicle information will not be displayed, and
the ECM Disconnected icon will be displayed in the lower right corner of the window.

Once the software has successfully established a connection to the ECM, the Engine Serial Number (ESN)
of the connected vehicle should be displayed on the Vehicle Information tab. If it does not appear, it may
be necessary to manually select the engine. Follow these steps to manually select the engine:

a. Inthe menu bar, select FILE > SELECT ENGINE. The Override Detected Engine window appears.
b. Select the type of engine in the connected vehicle.
c. Click OK.

15
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MANUALLY SELECTING THE INTERFACE CABLE

Once the EST is connected to the vehicle with an appropriate interface cable, NED should autoconnect with
the vehicle without having to select the protocol. If NED fails to autoconnect, follow these steps to manually
select the interface cable:

Navistar Engine Diagnostics - Default E]
File View Sessions Tests Procedures Help
- [iz} Tg @ & Activate Com Link F6 L*‘ i
=35 £ | Trip R ..
5 5 O 4|[0]" Y o Reper
Select Com Link ) NEXIQ Technologies USB-Link2 »
Display PVC...

Simulate Engine 4

Snapshot Trigger Setup...

Arm Snapshot Trigger

o/ OH

Start Recording Snapshot

Snapshot Recording Interval 4

L‘L]

Clear Statistics

Reset Trip Report
Reset VETS
SAE Signal Names

0000414027
Figure 13 Manually Select Com Link
1. In the menu bar, select TOOS > SELECT COM LINK.
2. Select the interface cable being used
3. Select the protocol:

« J1708 — All pre-2007 electronic engines
+ J1939 — All 2007-2010 electronic engines

4. |If software is still unable to connect, see the troubleshooting documentation provided for the specific
interface cable being used.

5. If cable is not at fault, see CAN Communications or J1939 in the “Electronic Control Systems Diagnostics”
section of applicable Engine Diagnostics Manual.

16
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USER INTERFACE

When Navistar Engine Diagnostics is started, a Default session displays as the opening screen. The following
is a brief description of each area displayed in the Default session.

THE MENU BAR

1 [ Navistar Engine Diagnostics - Default

File View Sessions Tests Tools Help

¢ = '
LS9 EB04

] - 7
\xi?’) Vehide... ﬁ Trip Report...

[I*][s]| @

1. Menu Bar

0000413973

2. Toolbar
Figure 14 Menu Bar and Toolbar

The menu bar (Figure 14, Item 1) contains a row of menus. Select a menu title to display the options in that
menu. Selecting an individual option allows the user to perform a task within the software.

File Menu

The File menu contains various file management and print options as well as the option to manually select
the type of engine connected.

Item

Description

Online Mode

Removing the check from this option puts the application in diagnostic only mode.
This is largely for backward compatibility with an older method of licensing Navistar
software, which allowed limited (diagnostic only) access to individuals who did not
have a license. Since the current licensing model requires all users to have a license
key, there is currently no need to check or uncheck this box. (Leave it checked.)

Select Engine

Used to manually select an engine (when an engine is not detected) or override the
detected engine.

Open Snapshot
Recording File

Opens a specified file containing recorded session data. (See Viewing Navistar
Engine Diagnostics SnapShots, page 39)

Export Parameters

Export engine parameters to a file. (See Exporting Parameters, page 43)

Create Template

Creates a new parameter template. (See Creating a Parameter Template, page 56)

Open Template

Opens an existing parameter template. (See Opening an Existing Parameter
Template, page 58)

Print Prints the trip report or the vehicle trip report. Alternately, these reports can be
exported to a file.
Exit Close the Navistar Engine Diagnostics software.

17



USER INTERFACE

View Menu

The View menu specifies what data is displayed by Navistar Engine Diagnostics.

Check the first item in this menu, Display Metric Units of Measure, to display metric values in Navistar Engine
Diagnostics. Uncheck this item to display English measures.

The remaining items in this menu enable or disable the display of individual tabs within the session view.

Sessions Menu

The Sessions menu allows sessions to be loaded and saved.

Item

Description

Load Session

Loads a previously saved session. (See Loading a Saved Session, page 34)

Save Session

Saves the current session. (See Saving Session Files, page 33)

Rename Session

Allows a new name to be entered for the current session.

Default

Switches to the Default session view, which monitors all position, temperature, and
pressure sensors. (See Default Session View, page 23)

Parameters Switches to Parameters session view, which monitors vehicle events. (See Viewing
All Parameters, page 44)
Signals Switches to Signals session view, which monitors specific signals.

The following items appear only when connected to a vehicle or simulating an engine.

Driver Switch
Controls

Displays a pre-defined session that monitors driver inputs such as whether cruise
control has been switched on or how much the accelerator pedal has been
depressed.

HD-OBD Monitors

Display a pre-defined session containing information about whether each of the fault
monitors have completed their cycles.

Programming

Displays several tabs that contain programmable parameters.

Hard Start — No
Start

Displays a pre-defined session with signals used to diagnose a hard start / no start
complaint.

Performance

Displays a pre-defined session with signals related to performance issues.

Vehicle Events

Displays the Vehicle Events tab. (See Vehicle Events Tab, page 63)

Vehicle Trip Report

Displays the Vehicle Trip Report. (See Vehicle Trip Report, page 62)

Event Data Recorder

Displays information related to abrupt stops.

18




USER INTERFACE

Tests Menu

The Tests menu displays a list of tests that can be initiated for the connected engine. If no engine is connected
or no tests are available for the connected engine, this menu will not appear at all.

Item

Description

Load Test Specific Session

A check next to this option indicates that the current session will automatically
load when a test is run.

KOEO Tests

KOER Tests

KOEO Aftertreatment Tests

KEOR Aftertreatment Tests

The list of tests displayed in these submenus will vary depending on the type
of engine connected. Consult the appropriate Engine Diagnostic Manual for
information on running the tests that apply to a specific engine.

Submenus that do not contain any tests for the connected engine will be
hidden.

Cylinder Performance
Analyzer

If Cylinder Performance Analyzer (CPA) is installed, selecting this option
launches it.

If CPA is not installed, this option is hidden.

Procedures Menu

The Procedures menu displays a list of procedures that can be initiated for the connected engine. If no engine
is connected or no procedures are available for the connected engine, this menu will not appear at all.

Item

Description

KOEO Procedures

KOER Procedures

KOEO Aftertreatment
Procedures

KEOR Aftertreatment
Procedures

The list of procedures displayed in these submenus will vary depending on the
type of engine connected. Consult the appropriate Engine Diagnostic Manual
for information on executing the procedures that apply to a specific engine.

Submenus that do not contain any procedures for the connected engine will be
hidden.
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Tools Menu

The Tools menu contains a collection of helpful functions.

Item

Description

Activate Com Link

Turns the connection to the ECM on and off.

Select Com Link

Manually select the type of interface cable used to connect to the vehicle. (See
Manually Selecting the Interface Cable, page 16)

Simulate Engine

Simulates the data that would be returned by a specified engine controller.
Data received from any engine that is actually connected to Navistar Engine
Diagnostics will be ignored. To resume receiving data from an engine that is
physically connected to Navistar Engine Diagnostics, halt the simulation by
unchecking this option or by restarting the application.

Snapshot Trigger Setup

Opens the Snapshot Trigger Setup window. This window is used to specify
the conditions under which to begin recording session data. (See Triggered
Recording, page 37)

Arm Snapshot Trigger

Enables or disables triggered recording. (See Triggered Recording, page 37)

Snapshot Recording
Interval

Sets the data sampling rate for recorded sessions.

Clear Statistics

Resets the minimum, maximum and average values for all applicable signals.

Reset Trip Report

Resets the trip report. This permanently erases the information about the current
trip from the engine.

Reset VETS

Resets vehicle events. This permanently erases vehicle event information
from the engine.
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Help Menu

The Help menu allows detailed information about the Navistar Engine Diagnostics software to be displayed.

Item Description

About Displays version information for the Navistar Engine Diagnostics software. (See
About Navistar Engine Diagnostics, page 27)

Visit Website Opens the Navister Service Software webiste.
https://www.navistarservicesoftware.com/

Messages Displays messages received from Navistar. (See Messages from Navistar, page 26)

Detailed Logging

Select this item to enable detailed logging. (A check appears next to this item when
detailed logging is enabled.) Select this item again to disable detailed logging.

Registration

Displays registration information for Navistar Engine Diagnostics on this system and
other computers that use the same product key.

If you have a multi-user license for the Navistar Engine Diagnostics software, the
first user to install the software with your product key becomes the administrator
for the individual user licenses. Some items on this menu are visible only to the

administrator.

License Agreement

Displays the end user license agreements for Navistar Engine Diagnostics and its
components.

Pending History
Uploads

Displays a list of pending vehicle history uploads.

View Log

Displays the diagnostics log. If you contact Navistar support, they may ask you to
send them a copy of this log.
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THE TOOLBAR

/S /)
D[P

s]| ¢

9

/o

;:g'

&?’j Vehide... \?j Trip Report...

0

©.

0000414018

Figure 15 Toolbar Icons

— |

6@3

Trip Report...

Item | Icon Description
1 ) Communication Link Button. The communication link button turns the connection
ﬂfg to the ECM on and off and displays connection status.
2 Trigger Setup Button. Opens the Snapshot Trigger Setup window. This window
is used to specify the conditions under which to begin recording session data.
(See Triggered Recording, page 37)
3 Trigger Arm / Disarm Button. The trigger arm / disarm button enables or disables
O triggered recording. (See Triggered Recording, page 37)
4 p— Data Record Button. The data record button records signal and parameter
L‘ information using various recording intervals. (See Snapshots: Recording
Session Data, page 35)
4 Default Session Button. Switches to the Default session view, which monitors all
D position, temperature, and pressure sensors. (See Default Session View, page 23)
6 Parameters Session Button. Switches to Parameters session view, which
P monitors vehicle events. (See Viewing All Parameters, page 44)
7 Signals Session Button. Switches to Signals session view, which monitors
S specific signals.
8 Stop Tests Button. This will stop any test that Navistar Engine Diagnostics is
currently running. Such tests are initiated in the Tests menu.
9 - Print Vehicle Diagnostics Button. Prints vehicle information.
(;35 Vehide...
10 Print Trip Report Button. Prints the vehicle activity report.
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DEFAULT SESSION VIEW

Vehid Information | \ Connection | Vehidle Status | Pressure | Position/Percent | e [ Voltage | switches | Al Signals| Vi
\ Information ‘ /
Engine Type: iaxxForce 11/13 (2008 - 20 J1939 Module Connection [¥]lok
Software Identification: 466HM2U8 . ) N N " R
ECM Cal: M1372 This is a Engine Electronic Control System Diagnostic Tool. =
ACM Cal: M1372 E
Engine Family Rating Code: 7D91 Engine Auto-Detection:
Vehide Identification Number: 1SIMENGENVINIGENG - The Calibration ID is used to detect the engine at Key On, Engine Off or Engine Run. If engine
Engine Serial Number: 466HM2U3000000 is NOT detected, Select it from the popup Engine selection window. Selecting the wrong engine
EIM Customer Unit Number: 0000000000 will display incorrect data.
Transmission Type: v
Rated Power: 412 hp
Connection (Sniffer,
Total Mies: 49,674,815.6 miles on (Snifer) |
Total Fuel Used: 2,282,479.85 gal Y| Protocol |Source Addr... |Module Name ~ |Count
Total Engine Hours: 153,736,696.2 hr J1939 0 Engine 107413
J1939 61 Exhaust Emission Controller 344
J1939 249 Off Board Diagnostic-Service Tool 3059
| n ] »
Diagnostic Trouble Codes | Datalink Traffic | DTC Log [ Stand Alone Real Time Clock|
Y|DTC SPN ~ |FMI Type Freeze Fra... [Message Count Module 3
1163 7137, 10|Pending Open EGR Position Sensor/Circuit Fault 35 Engine /
1164 2791 3 Open EGRP signal Out of Range HIGH 37 Engine Ed
N/A 222 2|Previously Active Open Unknown DIC 222 : 2 (Unknown SPN (222) - Data err...|99 Engine
N/A| 111 3 Open [Unknown DTC 111 : 3 (Engine Coolant Level 1 - Vol...|[37 Engine
N/A 51 3|Pending Oper [Unknown DIC S1 : 3 (Engine Throttle Valve 1 Posit...|99 Engine
N/A 27| 0 Open Unknown DIC 27 : 0 (Engine Exhaust Gas Recirculat...|33 Engine
N/A| 27 4 Open [Unknown DIC 27 : 7 (Engine Exhaust Gas Recirculat...(33 Engine
[ clearpTCs | [ Refresh DTC/Vehide Events
0000413974

Figure 16 Panes in Default Session View

Vehicle Information Pane

The Vehicle Information pane provides vehicle information for the connected vehicle. Displayed

information includes items similar to:

* Engine Type

+ Software Identification

+ ECM Cal

+ ACM Cal

* Engine Family Rating Code
* Vehicle Identification Number
* Engine Serial Number

*  EIM Customer Unit Number
*  Transmission Type

* Rated Power

« Total Miles

» Total Fuel Used

» Total Engine Hours
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Connection Pane

The connection pane contains a number of tabs that display current engine and vehicle data. The tabs
include:

* Connection (Sniffer) Tab. This tab provides real-time monitoring of the network activity for each
module on the various data links. The data presented here is used to identify if the individual modules
are present and communicating on the vehicle networks.

* Vehicle Status Tab. This tab displays system status information, such as Diesel Particulate Filter (DPF)
Regen status and the Engine Shutdown timer.

* Pressure Tab. This tab displays all ECM-monitored pressure sensors.

» Position / Percent Tab. This tab displays all ECM-monitored positon sensors.

»  Temperature Tab. This tab displays all ECM-monitored temperature sensor information for the engine.
+ Voltage. This tab shows actual voltage values for each sensor.

+ Switches. This tab displays the status of all monitored switches.
Diagnostic Trouble Code (DTC) Pane

The DTC pane displays all active or previously active ECM DTCs. DTCs can also be cleared in this pane.
The DTC pane is displayed in all of the software Default sessions.
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STATUS BAR

1

\

Build NED.V1.19.201612140930 ~ Engine Diagnostic Test Status

0000413975

Figure 17 Status Bar
1. Tool Information Area

This area displays tool information such as what tests are running, which have been completed, and
which have been aborted.

2. Update Information Area
This area displays information about updates to the Navistar Engine Diagnostics software.

3. ECM Connection Status Icon
The ECM connection status icon is used to show connection status between the ECM and the EST. The
left plug represents data traveling to the ECM. The right plug represents data traveling from the ECM.
When both sides are green and connected, data is flowing between the ECM and EST. It separates when
the ECM stops responding to requests.

Additional status information for Navistar Engine Diagnostics software can be found in the following locations:

* The Service Messages from Navistar window (See Messages from Navistar, page 26)

« The About Navistar Engine Diagnostics window (See About Navistar Engine Diagnostics, page 27)
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MESSAGES FROM NAVISTAR

7 N

Messages from Navistar @
1|0 Subject Hide
PROD 000 Navistar Engine Diagnostics ]
PROD 003 Future Functionality ]
PROD 012 Sessions Menu Moved ]
PROD 014 Programming Session Updated ]
PROD 015 User ID may be Required ]
PROD 016 IC4 Cable No Longer Supported ]
PROD 017 The Auto Protocol Detection has b... 0]
PROD 018 J1708 Service ]
This is a new International MaxxForce Engine Service Tool from Navistar.

0000414148

Figure 18 Messages from Navistar

After an update, Messages from Navistar window (Figure 18) will pop up to display important messages
about the updated version.

Suppressing the Display of Previously-Viewed Messages

To disable a message and prevent it from being displayed in the future, check the box in the Hide column of
the message to be disabled.

Viewing Past Messages

To view past messages, select HELP > MESSAGES in the menu bar.
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ABOUT NAVISTAR ENGINE DIAGNOSTICS

Figure 19 About Navistar Engine Diagnostics Window

(1) About Navistar Engine Diagnostics by Navistar, Inc. (=]

N/YISETAR

NED

Java HotSpot(TM) Client VM 25.45-b02

Application Version NED.V1.29

Library Versions q:x util: 16664 sf: 211 bus:970 env:PROD
Data Version 201701241545

Server https://evalueb.internationaldelivers.com/servicetools/servicemaxx/ned/
©2017 Navistar, Inc.

[ Ghorgeion ] [ ]

0000414144

The About Navister Engine Diagnostics window displays information about the current version of the Navistar

Engine Diagnostics software.

To open this window, select HELP > ABOUT in the menu bar.

Viewing the Change Log

The change log contains information about the contents of each update to the Navistar Engine Diagnostics

software. To view the change log:
1. In the menu bar, select HELP > ABOUT.

2. Click the CHANGE LOG button.
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SESSIONS

Sessions can display vehicle and engine information, such as: module calibration, sensor signals, and actuator
command signals. Special engine and vehicle features can also be programmed using these sessions.

Navistar Engine Diagnostics has many default sessions that load automatically when running any Service
Bay Test or Service Tool Procedure. Users are not limited to any default session. Users are able to build
their own session and save or load it at any time.

Navistar Engine Diagnostics also has a few added sessions that do not load automatically, but can be selected
from the Sessions drop-down menu. These sessions are available to help diagnose common systems and
program special features.

Predetermined sessions can be accessed from the Sessions drop-down menu.

SESSIONS MENU

Load Session...
Save Session...
Rename Session...
Default

Parameters

Signals

[«] =] (o]

Driver Switch Controls
HD-OBD Monitors

Programming

Hard Start - No Start

Performance

Vehicle Events
Vehicle Trip Report

Event Data Recorder

0000414180

Figure 20 Sessions Menu (Connected to Vehicle)
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Test:

w

v Load Test Specific Session
KOEO Tests »
KOER Tests »
KOER Aftertreatment Tests »

0000414105

Figure 21 Load Test Specific Session

Some sessions are associated with service bay tests and will automatically load when a test is commanded.
However, the user does have the option to disable the automatic load feature in order to run a test using a
different session.

NOTE - A check mark next to the Load Test Specific Session menu option (Figure 20) indicates the
session will automatically load.
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BUILDING A SESSION

Users can build their own sessions to monitor specific parameters or signals not usually grouped together.

\ /
P|IS

2

\

\cjj Vehide... \»% Trip Report...

0000414155

5B 0%

1. Parameters button 2. Session button

Figure 22 Menus and Toolbar

1. In the Toolbar, select either the Parameters button (Figure 22, Item 1) or the Signals button (Figure
22, ltem 2).

2. Select desired signals by checking the boxes in the Watched column.

3. Once all desired signals have been selected, click on the Only Show Watched box to hide all signals
that were not selected.

NOTE - The list may be scrolled up and down using the window scroll bar.

View

Display metric units of measure

<

Datalink Traffic
v Diagnostic Trouble Codes
Permanent Diagnostic Trouble Codes

Instructions

Parameters
Signals
v Sniffer
v Stand Alone Real Time Clock

v Vehicle Information

0000414182

Figure 23 View Menu

NOTE - Other information can be added to a session by selecting any of the items from the View menu.
All columns displayed are moveable and configurable. Right-clicking on a column header allows the
user to add or remove columns.
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10 N\
0.9
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1400 1425 1450 1475 150.0 1525 155.0 157.5 160.0 1625 185.0 187.5

seconds

L7

deg
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\
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0000413963

1. Signal graph display pane 4. Graph legend
2. Only show watched box 5. Signal list
3. Watched column boxes 6. Filter button

Figure 24 Signals Session
NOTE - Displayed signals are represented by different colored graph lines. When multiple signals are

displayed, signal identification can be made using the graph legend. Check the box in the Watched
column to show the graph for a desired signal. Uncheck the box to hide that signal’s graph.
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VIEWING AND CLEARING SIGNAL VALUE STATISTICS

Navistar Engine Diagnostics records minimum, maximum, and average values for every signal (when

applicable).
T|D |Name [ value .~ |Abbreviation Units Watched
-30 |Active DIC Codes Group 11:3[DICs O] -
27  |EGR Position D 5.83|EGRP % O] @
51 Engine Throttle Position 8.4[ETP $ ] ‘
69 Two Speed Axle Switch Name ange|TSAS [
70 Parking Brake Switch Abbreviation Set|PBS ]
74 Maximum Vehicle Speed Li Source 58|MVSL mph ]
84 [Vehicle Speed 1.19|VSS |mph [
86 Cruise Control Set Speed Raw Value ojccss |mph 0]
87 Cruise Control High Set | Raw Units 61|CCHSLS Imph [
g8 Cruise Control Low Set L| 62|CCLSLS mph 0]
91  |Accelerator Pedal 1 Outp Value 0.8/APP1 5 )
92 Engine Load Min Value 6|EL $ ] -
Max Value
Avg Value
Units
Rate (ms)
Watched

Sort matching rows to top.

Clear matches

Figure 25 Signal List: Right-Click Menu

Viewing Signal Value Statistics

1.

0000414022

Right-click on the title bar at the top of the signal list. The right-click menu for the list appears (Figure 25).

2. Select (check) Min Value, Max Value, or Avg Value to add that statistic. Each checked item will be

displayed as a column in the signal list.

Resetting Minimum, Maximum and Average Values

In the menu bar, select TOOLS > CLEAR STATISTICS.
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SAVING SESSION FILES

Load Session...
Save Session...

Rename Session...

M Default
m Parameters
[§J Signals

0000414179

Figure 26 Saving a Session File

Built or modified session files can be saved to be loaded at a later time. This does not effect any of the
software’s pre-made sessions.

1. In the menu bar, select SESSIONS > SAVE SESSION.
2. Navigate to the folder in which you wish to save the session file.
3. Type the desired session name in the File name box.

4. Click Save.
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LOADING A SAVED SESSION
1. In the menu bar, select SESSIONS > LOAD SESSION.

[£] Open Dﬁz
Lookin: | |. Navistar Engine Diagnostics > @
. denim
I i
&} I History
Recentltems |J logs

|| my_session.session

Desktop

=
WTCSVWOL....

ﬁA\‘

Computer

T

@ e
ek ot tne: et gne b 5

0000414021
Figure 27 Opening a Saved Session
2. Select the session file to be opened.

3. Click OPEN.
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SNAPSHOTS: RECORDING SESSION DATA

Navistar Engine Diagnostics can record signal information using various data sample rates (Recording
Intervals). Recording Intervals can be selected using the Tools menu.

Tools
2 ; :
& Activate Com Link F6
Select Com Link 4
Simulate Engine »
i;},‘ Snapshot Trigger Setup...
O Arm Snapshot Trigger
‘9 Start Recording Snapshot
Snapshot Recording Interval ) real time
p— v 0.2 seconds
‘{] Clear Statistics 05 seconds
Reset Trip Report 1 second
Reset VETS 5 seconds
10 seconds
30 seconds
1 minute
5 minutes
10 minutes
30 minutes
1 hour
0000414025

Figure 28 Recording Interval Selection

Using the Recording Interval scale, the user can adjust the amount of data being recorded in a snapshot. The
default setting is 0.2 seconds.
=3

Figure 29 Record Button
1. Click the Record button in the Toolbar to start recording the current session.

NOTE — When the Recording function is active, the Record button displays a Stop sign.

>

|
‘\w

Figure 30 Record Stop Button

2. Click the Record Stop button to stop recording.
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File Saved ==

l/.—\l The following snapshot was saved:
& C:\Users\u01m189\Desktop\SnapShots\VINIGENG_Signals_2017 01 11 13 42 24 813en_US-slk.zip

[LOK I[ Open ][ Open Directory ]

0000414026

Figure 31 Recording Saved Window

3. When recording is stopped, a pop up message alerts the user to the file name and location of the recorded
snapshot. Files created with the recording function are saved in the SnapShots desktop folder.
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TRIGGERED RECORDING

Navistar Engine Diagnostics uses triggered recording to record signal data automatically, based on conditions
determined by the user. Triggered recording is helpful when recording snapshot information while trying to
duplicate an operating condition. Once the condition is met (trigger is set), recording automatically begins.

Setting Up a Triggered Recording

Figure 32 Trigger Setup Button

1. Click the Trigger Setup button in the Toolbar.

p=

= Snapshot Trigger Setup (23]

Record Pre-Trigger | 10 (s) Post-Trigger | 120 (s) Recurring Trigger [] Save

Fill all fields before saving trigger. -
Y I Signal Logic Value Unit Remove

v (. Remove
V: Engine Oil Pressure (521524) -

=gle’ O emperat
V: Exhaust Gas Redrculation Temperature (521534)
V: Fuel Delivery Pressure (521525)
V: Fuel Rail Pressure (521523)
V: Humidity (521539)
V: Inlet Air Temperature (521538)
V: Intake Manifold Pressure (521521)

« [uJ

m

0000414031
Figure 33 Selecting a Signal
2. In the Signal column, select a signal to trigger.
3. Inthe Logic column, select a trigger operator (greater than, less than, equal to, not equal to).
4. In the Value column, specify the value for this signal that will serve as the trigger.

5. If more than one signal will serve as a trigger, click the ADD CRITERIA button and repeat steps 2 to 4
for each desired signal.

6. If recording should begin prior to the trigger value being met, enter to the number of seconds to record
prior to the trigger in the Record Pre-Trigger box.

7. Inthe Post-Trigger box, enter the number of seconds to continue recording after the trigger value is met.
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8. Ifrecording should occur every time the trigger value is met during the current session, check the Recurring
Trigger box. Leave the box unchecked if recording should occur only the first time the trigger value is met.

9. Click SAVE.

<)

Figure 34 Trigger Arm / Disarm Button

10. To arm the trigger, click the Trigger Arm / Disarm button in the Toobar.

NOTE - Triggered recording begins automatically when the trigger value is met (or, if a Record
Pre-Trigger value was entered, a number of seconds prior to the trigger being met).

NOTE - To disable triggered recording, click the Trigger Arm / Disarm button again.
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VIEWING NAVISTAR ENGINE DIAGNOSTICS SNAPSHOTS

A snapshot is engine data that is recorded at a preset interval, during a session, and saved. There are
two ways to view a snapshot:

* In the menu bar, select FILE > OPEN SNAPSHOT RECORDING FILE.
*  Open the SnapShots folder on the Windows desktop.

Viewing a Snapshot in Navistar Engine Diagnostics

1. In the menu bar, select FILE > OPEN SNAPSHOT RECORDING FILE.

~

|%) Open
Lookin: | | SnapShots > #ermE-

g L = |
b
Recent Items
Desktop

5
WTCSVWOL....

Ay

Computer

@ File name: “ ] [ Open ]

Network .
oy Files of type: [SymbolicLinkﬁleoraZIPofaSymbolicLinkﬁle v}

0000414006
Figure 35 Opening a Snapshot File
2. Select a previously recorded file.

3. Click OPEN.

39



SESSIONS

Engine Type: MaxxForce 11/13 (2010 - 2012) Software Identification: 466HM2U8
Vehide Identification Number: 1SIMENGENVINIGENG Engine Serial Number: 466HM2U3000000
EDC Customer Unit Number: 0000000000 Transmission Type: 0000000000
Rated Power: 12.5 hp Total Miles: 2,195,237.8 miles
Total Fuel Used: 74,012,610.3 gal Engine On Time: 215,141.01 hr
[ savesaeenshotas G... | [ PrintSaeenshot.. |
40
35
30
25
20 — Number of Warm-ups Since DTCs Cleared ()
15 Active DTC Codes ()
1.0 Pending Trouble Codes ()
05
0.0
0 25,000 50,000 75000 100,000
Time
00:00.000 0
KHamwn [ Show Gaphed only
¥ | Name Value Units Graph
Active Trouble Codes|0.0 [
Previously Active...[36.0 ]
Distance Since Di...[17012.0 miles E
Number of Warm-up...|2.0
Time Since Diagno...|23441.0 min
Active DIC Codes 111:3
Emission Related ...[1.0
MIL-On Trouble Codes|1.0
Pending Trouble C...[1.0
Permanant Trouble...[1.0 =]
Previously MIL-On...[1.0

0000414010

Figure 36 Recorded Signal Playback

4. Select which signal(s) to view by checking the desired boxes in the Graph column.
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VIEWING DIAGNOSTIC TROUBLE CODES

VIEWING DIAGNOSTIC TROUBLE CODES
THE DTC PANE

DTCs can be viewed can cleared from any session menu using the DTC pane.

\\N /)

DB.\wsucTro ible Codes | Dataly/k Traffic | /TC Log | Stand Alone Real Time Clock| . g BT e e N L T
LELR SPN ~ |[FMI [Type ’ Freeze Frame |Message Count Module
‘N/A 7137 10|Pending [ Open Unknown DIC 7137 : 10 (Tire 25 Pressure - Abnormal... (103 Engine -
N/A 2791 3 [ Open EGR voltage too HIGH 100 Engine
N/A 222 2|Previously Active Open Unknown DIC 222 : 2 (Unknown SPN (222) - Data erra... (99 Engine
N/A 111 3|Active ( Open Unknown DIC 111 : 3 (Engine Coolant Level 1 - Volt... |35 Engine 5‘
N/A 51 3|Pending ( Open ETP signal Out of Range HIGH 99 Engine |
N/A 27 0 Open EGRP fault: over temperature 101 Engine g
N/A 27 7 Open JIEGRP does not agree with commanded position 102 Engine X
[ Clear DTCs ] [ Refresh DTC/Vehide Events ]
N\
5
0000413964
1. Diagnostic Trouble Code (DTC) 4. Type column (Active / Previously
column (pre-2010) Active / Pending)
2. Suspect Parameter Number (SPN) 5. Clear DTCs button
column
3. Failure Mode Indicator (FMI)
column

Figure 37 DTC Pane

DTC IDENTIFICATION

DTC identification is accomplished using two fault code identifiers. These two identifiers, known as the
SPN and the FMI, are displayed in the DTC Window.

Identifier Type Description

Supsect Parameter Number (SPN) [ The SPN identifies the individual component causing the DTC.

Failure Mode Indicator (FMI) The FMI identifies the fault or condition effecting the individual
component.

Diagnostic Trouble Code (DTC) The DTC is a 3-digit or 4-digit number used to identify DTCs. This
3-digit or 4-digit number is only used on pre-2010 engines.

NOTE - 2010 model year vehicles no longer utilize DTC identification by number. DTCs are now identified
using the SPN and FMI only.
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DTC TYPE

DTC Type Description

Active Faults that are currently present.

Previously Active Historical faults that may be set by intermittent conditions, or by an operating
condition which is not currently present.

Pending Faults that occurred on the first drive cycle. Such faults become Active if they are
detected again on the second drive cycle

Healing) Healing DTCs are previously active faults that were not detected on a subsequent
drive cycle. If the same fault is not detected for three consecutive drive cycles, it
becomes Previously Active. If it is detected again within three drive cycles, it returns
to the Active state.

VIEWING FREEZE FRAME DATA

Freeze frame data is a snapshot of the engine operating condition at the time the fault was detected. To view
freeze frame data for a particular fault, click the button in the Freeze Frame column.

CLEARING DTCS

All inactive DTCs can be cleared from the ECM using the following procedure.
1. Click Clear DTCs.

2. Cycle the ignition switch.
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PARAMETERS

This section describes how to export and view all parameters, search parameters by group, search parameters
by name, and change dealer programmable parameters.

NOTE - It is recommended that parameters be exported prior to programming any Navistar electronically
controlled engine.

EXPORTING PARAMETERS

1. In the menu bar, select FILE > EXPORT PARAMETERS.

P B\
|£) Save (=]
Savein: \ . Navistar Engine Diagnostics v | ? 7 '
} .. denim
=) Hist
- } .. History
Recent Items 1 logs
.. temp
Desktop
&
WTCSVWO1....
L
Computer
Pe- U =
w File name: IVINIGENG.csv! I [ Save ]
Network Files of o ]
iles of type: | Comma Separated Values v |

0000414015
Figure 38 Saving Exported Parameters
2. Enter a FILE NAME to use for the parameters to be saved.

3. Click SAVE.

NOTE - Engine parameter data files are saved as .csv files. This file type encodes data as text,
with individual values separated by commas. This format is commonly used for importing data into
spreadsheets such as Microsoft Excel® as well as other data manipulation tools.
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VIEWING ALL PARAMETERS

P

Figure 39 Parameters Button

To view all parameters, click the Parameters button in the Toolbar. The Parameters pane appears.

Parameters

| [ * Undo All Changes..: ) ][ 7Program Engine..: B ] Only Show Watched

¥|D Name ~ [value units  |undo  [watc...
75203|AESC - APS Maximum Engine Speed Override RPM E_ -
75342|AESC Disable with Parking Brake E_@
58251|AESC Mode 4 Trip Engine Hours 24,384.83 hr ]
58001|AESC Mode 4 Trip Fuel Used 83,413,174.7 gal [Z_
58261|AESC Mode 5 Trip Engine Hours 76,248.09 hr E_
S58011|AESC Mode S5 Trip Fuel Used 104,227,297.5 gal E_
58271|AESC Mode 6 Trip Engine Hours 17,907.23 hr E
58021|AESC Mode 6 Trip Fuel Used 39,033,007.5 gal
76102|Adaptive Cruise Control Enable [Vorad Enable ||
74081|Ambient Temperature Override Enable
99312|Auxiliary Engine Shutdown Switch Input Selection Use CAN input 1
75253|Auxiliary Engine Speed Control - Bump Up/Down Step RPM ||
75102|Auxiliary Engine Speed Control - Disable With Clutch
75132|Auxiliary Engine Speed Control - Disable with APS APS is Ignored
75112|Auxiliary Engine Speed Contreol - Disable with Brake _
75183|Auxiliary Engine Speed Control - Engine Speed Limit with VSS ... RPM ||
75243|Auxiliary Engine Speed Control - Engine Speed Throttle Down R... RPM/s
75021 Anwiliary Fnaine S A Contrnl — In Cah Mnode INane. [ Y

0000414007

Figure 40 Parameters Pane
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SEARCHING PARAMETERS BY GROUP

P

Figure 41 Parameters Button

1. Click the Parameters button in the Toolbar.

\ Parameters
\ Undo All Changes... Program Engine... | []] Only Show Watched
¥|D Name ~ |value Units  |undo  [watc...
75203|AESC - APS Maximum Engine Speed Override RPM ] -
75342|AESC Disable with Parking Brake ] E‘
58251|AESC Mode 4 Trip Engine Hours 24,384.83 hr |
S8001|AESC Mode 4 Trip Fuel Used 83,413,174.7 gal (=

0000413965

1. Filter icon

Figure 42 Parameter Filter

2. Click on the filter icon (Figure 45, Item 1). A window that lists parameter groups appears.
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Find =]

Y | Groups

Customer Password

Engine Serial Number

Hydraulic Pressure Governor

Coclant Tank Selection

Cold Ambient Protection

Genesis Engine Run-Up On-Demand Diagnostic Test
EECM Manufacturing Data

\Vehicle Retarder

Engine Crank Inhibit

Engine Idle Shutdown Control

Engine Speed Control

Cruise Control

Engine / Powertrain Warning And Protection System
0il & Coolant Warning Time

Road Speed Limiting And Anti-Tampering

Two Speed Axle

Engine Family / Transmission

0il & Coolant Warning Limits

Engine Fan Control

Vehicle Identification Number

Genesis High Pressure Pump On-Demand Diagnostic Test
Engine Air / Gas Management (Engine Configuration)
Accumulators

Vehicle Configuration

Service Interval

Enter search words: [ ]

[Lgear J[Lok ][ concel ]

0000414002
Figure 43 Parameter Group List
3. Select the group to be displayed.
4. Click OK. The parameters in the selected group will be brought to the top of the list.

NOTE - To clear the search and return the list to its original order, click the filter icon and then click
Clear.
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SEARCHING PARAMETERS BY KEYWORD(S)

[°]

Figure 44 Parameters Button

1. Click the Parameters button in the Toolbar.

\ Parameters
\ Undo All Changes... Program Engine... | []] Only Show Watched
¥|D Name ~ |value Units  |undo  [watc...
75203|AESC - APS Maximum Engine Speed Override RPM ] -
75342|AESC Disable with Parking Brake ] E‘
58251|AESC Mode 4 Trip Engine Hours 24,384.83 hr |
S8001|AESC Mode 4 Trip Fuel Used 83,413,174.7 gal (=

1. Filter icon
Figure 45 Parameter Filter

2. Click on the filter icon next to the ID column.

0000413965
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Find =]

Y | Groups

Customer Password

Engine Serial Number

Hydraulic Pressure Governor

Coclant Tank Selection

Cold Ambient Protection

Genesis Engine Run-Up On-Demand Diagnostic Test
EECM Manufacturing Data

\Vehicle Retarder

Engine Crank Inhibit

Engine Idle Shutdown Control

Engine Speed Control

Cruise Control

Engine / Powertrain Warning And Protection System
0il & Coolant Warning Time

Road Speed Limiting And Anti-Tampering

Two Speed Axle

Engine Family / Transmission

0il & Coolant Warning Limits

Engine Fan Control

Vehicle Identification Number

Genesis High Pressure Pump On-Demand Diagnostic Test
Engine Air / Gas Management (Engine Configuration)
Accumulators

Vehicle Configuration

Service Interval

Enter search words: [ ]

[Lgear J[Lok ][ concel ]

0000414002
Figure 46 Parameter Group List

3. Type the keyword(s) in the box labeled ENTER SEARCH WORDS and click OK. The parameters with the
keyword(s) will be brought to the top of the list.

NOTE - To clear the search and return the list to its original order, click the filter icon and then click
Clear.
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CHANGE ONE DEALER OR CUSTOMER PROGRAMMABLE PARAMETER

To prevent making unwanted changes to parameters, export parameters prior to making any changes. (See
Exporting Parameters, page 43)

NOTE — Non-Dealer or Non-Customer Programmable Parameters cannot be changed. In future versions
of Navistar Engine Diagnostics, they will be grayed out to make them easier to distinguish.

Changing a Parameter

P

Figure 47 Parameters Button
1. Click the Parameters button in the Toolbar.
2. Search for the parameter by group, keyword, or scroll through the list.
3. Change the parameter value. There are two types of programmable parameters:

*  Drop-down (See Changing a Drop-down Value, page 50)

*  Numerical (See Changing a Numerical Value, page 51)

1

Parameters \

I [ Undo All Changes... l[\ Program Engine... ] [] Only Show Watched

¥[D Name ~ |value Units  [undo  [watc...
99242|Brake Pedal Switch Input Selection : -
95092|Change Oil Lamp Activation Time E] 0]
95081|Change Oil Lamp Always On Yes ] =]
99252|Clutch Pedal Switch Input Selection Use CAN input 1 0] !
94001/Cold Ambient Protection Enable Disable 0]
77670|Coolant Level Low - Protection Light :
92003|Coolant Tank Selection Float Sensor :

0000414008

1. Program Engine button

Figure 48 Parameters Panel

4. Click Program Engine.
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@ Are you sure you want to program the changed parameters into the connected engine controller?

Confirm Programming

Yes I [ No

0000413999
Figure 49 Changed Parameters Prompt
5. Click YES.
6. Navistar Engine Diagnostics will attempt to use the default password.

* If the default password is accepted, you will not be prompted for one. Proceed to Step 7.

» If the default password doesn’t work, the software will ask for the customer password. Type the
customer password in the field provided and press OK.

7. Click OK.

Changing a Drop-down Value

1. Click the VALUE field of the parameter to be changed. An arrow appears on the right end of the field.

Disable With Clutch

Disable with APS

Disable with Brake Y | Description ~ |value
Engine Speed Limit with V5SS ... |APS Disable RAESC 2
Engine Speed Throttle Down R... |APS Overrides AESC Set Speed|l
In Cah Mode AP s Iqnored 0

0000414001
Figure 50 Value Pop-up
2. Click the arrow. A popup listing possible values for the selected field appears.
3. Select the desired value for the parameter.

4. Press the ENTER key on the keyboard or click elsewhere in the application.
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Changing a Numerical Value

MR Redd kR e

[Ava s

| =

H Disable
bet Engine Speed 1 (Set) 671 REM

tet Engine Speed 2 (Resume)

4

REM

=

tet Engine Speed 3

REM

SIS

sar Fn~rina Qraad A

DDV

Figure 51 Value Edit Box

1. Click the VALUE field of the parameter to be changed.

0000414003

2. Type the desired value for that parameter in the box including any decimal points.

3. Press the ENTER key on the keyboard or click elsewhere in the application.
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CHANGING MULTIPLE DEALER OR CUSTOMER PROGRAMMABLE PARAMETERS

NOTE - If changing multiple parameters on multiple vehicles create a parameter template. (See
Parameter Templates, page 55)

1. Follow all steps from Change One Dealer or Customer Programmable Parameter.

2. Repeat procedure for additional parameters that need to be changed.

UNDOING PARAMETER CHANGES BEFORE THEY ARE PROGRAMMED

Parameters 1 \

| l‘ Undo All Changes... ” Program Engine... JDOnIyShowWatched

v|D Name ~ |value Units  |undo  [watc...
75163|Auxiliary Engine Speed Control - Preset Engine Speed S RPM ] all_— 2
75173|Auxiliary Engine Speed Control - Preset Engine Speed 6 RPM /—,‘/_/
75072|Auxiliary Engine Speed Control - Ramp Rate 1,499 RPM/s Lcun=S)y ] \%
75041|Auxiliary Engine Speed Control - Remote Pedal Enable Disable Usisa [ |
75301|Auxiliary Engine Speed Control - Speed Controlled to Engine Load [On L
75213|Auxiliary Engine Speed Control - Vehicle Speed Limit mph ]
ANNANIDwata Nadal Ciidenk Tawmoae Calanedan [

0000413952
1. Undo All Changes button 2. Undo button for individual changed
parameter

Figure 52 Undo Buttons
There are two ways to undo changes:

* To undo changes to a single parameter, click the UNDO button for that parameter (Figure 52, ltem 2).
+ To undo changes made to ALL programmable parameters, click UNDO ALL CHANGES.(Figure 52, Item 1).
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CHANGING THE CUSTOMER PASSWORD

NOTE - Not available on MWM engines.

P

Figure 53 Parameters Button

1. Click the Parameters button in the Toolbar.

Parameters

| [ Undo All Changes... ]( Program Engine... ][:]OnlyshowWatched

7|D Name ~ [value Units
76032|Cruise Control Vehicle Speed Low Limit mph
99262|Cruise Control/AESC On/Off Switch Input Selection Use CAN input 1
87002 Customer Password
88013|Customer Reference Number 00000000
66082|DOC Serial Number 000000000000000

0000414000
Figure 54 Customer Password Parameter
2. Search for the parameter 87002 “Customer Password”.

3. Click the button in the Value column. A window that allows entry of the new password appears.

1

PasswordPanel.program @

Please enter the new value for Customer Password (8 character limit).
Both fields must be the same before the OK button will be enabled.

Enter New Password voooooooo

Re-enter New Password voooooooo

[] Show Password | OK

0000414151

Figure 55 Changing Customer Password
4. Enter the new password in both of the provided fields. (The two entered passwords must match.)

5. Click OK.
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Parameters

| [ Undo All Changes... ][\ Program Engine... ]On!yshowWatched

¥|D Name ~ |value Units Watc...
99242|Brake Pedal Switch Input Selection
95092|Change 0il Lamp Activation Time E]
95081|Change 0il Lamp Always On Yes

99252|Clutch Pedal Switch Input Selection

Use CAN input 1

94001(Cold Ambient Protection Enable

Disable

77670|Coolant Level Low - Protection Light

92003|Coolant Tank Selection

1. Program Engine button

Float Sensor

Figure 56 Parameters Panel

6. Click PROGRAM ENGINE.

0000414008

]

No ]

Confirm Programming E‘

@ Are you sure you want to program the changed parameters into the connected engine controller?

Figure 57 Changed Parameters Prompt

7. Click YEs.

8. Enter the current customer password and click OK (if prompted).

9. Click OK.

0000413999
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PARAMETER TEMPLATES

A parameter template is used to easily program a group of chosen parameters and values into multiple

vehicles within a short period of time.

A parameter template can also be used to copy a current list of configured parameter values or features from
one vehicle to another.

Suggested uses of parameter templates:

PTO / remote throttle settings
Driver reward settings

Road and cruise speed settings
Progressive shift

Service interval settings
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CREATING A PARAMETER TEMPLATE

There are two ways to create a parameter template: connected to the engine and not connected to the engine.

Creating a template when connected to an engine copies the current configuration of the connected vehicle
into the template. This data becomes the starting point for the template’s configuration.

To create a template when an engine is not connected, it is necessary to select the engine family to which
this template will apply. The default template parameters for the selected engine family become the starting
point for the new template.

P N
! )) Template Editor - New Template @
File
K (] ([0
Q Ml |S
Notes:
2 /
/
[MaxxForce 11/13 (2008 - 2009) ! - ] High Axle Rati...
\l Transmission T... 77 No,
N | [ cear ] [ search... | High Gear Rati... 11.23No
High Gear Rati... 17.57 No, -
Name Block E High Gear Rati... 12.60No_...
1 ~<5) Search Results - .. Low Idle Speed... Enable
\ @Q Engine Fan Control — Eng]}ne tl::amiy “ee idie ’;‘pee: gon. . = :210 REM/3 6
N| E’J Two Speed Axle >> J ngine Family ... Idle Speed Con... isable /

N#-) Engine Family / Transmission

™ Cruise Control

&-() Engine Idle Shutdown Control
-] Vehicle Retarder

m

A

Engine Family ... Idle Speed Bum... 22 RPM
Vehicle Config... Hard Brake Dec... 224.5 mph,
Engine Fan Con... Engine Fan Con... Disable

Engine Fan Con... Force Fan On W... Fan On w...
Engine Fan Con... Enable the fan... Disable

Q Engine Air/ Gas Management (Engine Config... Radiator Shutter Radiator Shutt... Disable
@Q Service Interval Radiator Shutter Radiator Shutt... 276 F
a Hydraulic Pressure Governor Radiator Shutter Radiator Shutt... -40F
Logmie o o o Y Coolant Tank S... Coolant Tank S... Float Se...

Hydraulic Pres... Driveline Stat... Neutral ...
Hydraulic Pres... Vehicle Speed ... Wheel Sp...
Service Interval Service Interv... Disable
Service Interval Fuel Used Serv... 6,902 gal
Service Interval Engine Hour Se... 260 hr
Service Interval Vehicle Distan... 45,184 miles
Service Interval Fuel Used Star...

0000413953
1. Available parameters list 4. Move all parameters button
2. Parameter search field 5. Move selected parameter button
3. Engine family drop-down 6. Selected parameters list

Figure 58 Template Editor Window
1. In the menu bar, select FILE > CREATE TEMPLATE. The Template Editor window appears.
2. If not connected to an engine, select the engine family to which this template will apply (Figure 58, ltem 3).

If connected to an engine, the correct engine family will be pre-selected and cannot be changed.
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Use the arrow buttons to move the parameters that will be included in the template to the list of selected
parameters on the right side of the window:

»  To move all parameters, click the Move All Parameters button (Figure 58, Item 4).

* To move a single parameter, select the parameter to move in the Available Parameters list. Then, click
the Move Selected Parameter button (Figure 58, Item 5).

4. Specify values for the selected parameters by editing the entries in the Value column. These entered
values will be saved in the template.

Figure 59 Save Template Button

5. Click the SAVE TEMPLATE button.

-
| %] Save =
Savein: { . Navistar Engine Diagnostics v| P
) .. denim
=] iy
3 1. History
Recentltems |+ logs
1. temp
Desktop
&8
WTCSVWO1....
A
L
Computer
/mA E
w File name: l [NIGENG.csv ] [ Save ]
Network .
Files of type: | Comma Separated Values v

0000414015
Figure 60 Save Parameters
6. Enter a FILE NAME to use for the new template.

7. Click SAVE.

NOTE - Save the template before beginning programming. Templates can only be programmed in
the same engine family, model, and year. Always check for the latest calibration using the calibration

scorecard.
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OPENING AN EXISTING PARAMETER TEMPLATE

~ =~
2 Open [3m
Look in: [ . Navistar Engine Diagnostic Engineering Test v. ? 9 '
. denim
Z: Hist
o | History
Recent Items i logs
|| My_parameters.template
Desktop
-
WTCSVWOL1....
A
Computer
l! File name: y_parameters. template
Network - r y
2l Files of type: [ Navistar Engine Diagnostics template fil v

0000414150

Figure 61 Open Template
1. In the menu bar, select FILE > OPEN TEMPLATE.
2. Select the template file to be opened.
3. Click OPEN.

NOTE — All parameter templates created with Navistar Engine Diagnostics have the filename extension
.template.
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USING THE TEMPLATE EDITOR

2 4

[/ /

0000413954

1 /)Tel \plate Editor[- New Templs/e
\ File
, ) 7
]
Notes: / /
-/
[MaxxForce 11/13 (2008-2009) /] High Axle Rati...
Transmission T...
[ | [ cear ][ search... | High Gear Rati...
High Gear Rati...
Name High Gear Rati...
: @ Search Results .. Low Idle Speed...
Q Engine Fan Control Engine Family ... Idle Speed Con... 36.0RPM/s
Q Two S dAd Engine Family ... Idle Speed Con... Disable
I IpgegiNie o Engine Family ... Idle Speed Bum... 22 REM
Q Engine Family / Transmission Vehicle Config... Hard Brake Dec... 224.5mph/s
Engine Fan Con... Engine Fan Con... Disable
@-{3) Engine Idle Shutdown Control Engine Fan Con... Force Fan On W... Fan On w...
ﬁ Vehicle Retarder Engine Fan Con... Enable the fan... Disable
/’ + D Engine Air/ Gas Management (Engine Config... Radiator Shutter Radiator Shutt... Disable
10 & service Interval Radiator Shutter Radiator Shutt... 276 F
Q Hydraulic Pressure Governor Radiator Shutter Radiator Shutt... -40F
D e Coolant Tank S... Coolant Tank S... Float Se...
Hydraulic Pres... Driveline Stat... Neutral ...
Hydraulic Pres... Vehicle Speed ... Wheel Sp...
’,/ Service Interval Service Interv... Disable
9 / Service Interval Fuel Used Serv... 6,902 gal
Service Interval Engine Hour Se... 260 hr
Service Interval Vehicle Distan... 45,184 miles
Service Interval Fuel Used Star...
Figure 62 Template Editor
Item | Name Description
1 Create Template Button | Starts a new blank template.
2 Open Template Button | Opens an existing template file.
3 Save Template Button | Saves the current template.
4 Lock Template Button Password-protects the current template. A locked template cannot be
edited without first unlocking with the password.
5 Engine Family Select desired engine family. Only available when not connected to the
Selection Drop-Down vehicle. When connected to vehicle, engine family automatically displays.
6 Template Notes Box Customer and / or vehicle information may be entered here to make the
template easily identifiable.
7 Program Engine Button | Programs the template’s parameters to the vehicle. This button is only
active when connected to a vehicle.
8 Selected Parameter Lists parameters that are selected from the Available Parameters list.
List These are the parameters that will be programmed to the vehicle when
the Program Engine button is clicked.
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Item | Name Description
9 Parameter Details Box | This box will display information about the selected parameter.
10 Available Parameters Lists all available parameters for the engine family selected above.

List
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CHANGING PARAMETER TEMPLATE VALUES

2 Template Editor - New Template

---D Engine Fan Control

&) Two Speed Axle

@) Engine Family/ Transmission

™ Cruise Control

@-(3) Engine Idle Shutdown Control

#-(2) Vehicle Retarder

#-(Z) Engine Air / Gas Management (Engine Config...
@~ Senvice Interval

&-(Z) Hydraulic Pressure Governor

£ 0 b Oleaadd,

Engine Family ...
Engine Family ...
Engine Family ...
Vehicle Config...
Engine Fan Con...
Engine Fan Con...
Engine Fan Con...

Radiator Shutter
Radiator Shutter
Radiator Shutter

Coolant Tank S...
Hydraulic Pres...
Hydraulic Pres...

Interval
Interval
Interval
Interval
Interval

Idle Speed Con...
Idle Speed Con...
Idle Speed Bum..
Hard Brake Dec...
Engine Fan Con...
Force Fan On W...
Enable the fan...
Radiator Shutt...
Radiator Shutt...
Radiator Shutt...
Coolant Tank S...
Driveline Stat...
Vehicle Speed ...
Service Interv...
Fuel Used Serv...
Engine Hour Se...
Vehicle Distan...
Fuel Used Star...

File
2 = Qo
BRI NS
Notes:
[MaxxForce 11/13 (2008 - 2009) v] Axle  High Axle Rati...  32,000.00No_...
Axle Transmission T... 771NO. ...
[se |[ clear ][ search... | Axle High Gear Rati... 11.23No_...
Axle High Gear Rati... 17.57No_...
Name Two Speed Axle High Gear Rati... 12.60No_...
@ Search Results Engine Family ... Low Idle Speed... Enable

36.0RPM/s
Disable
22 REM
224.5mph/s
Disable
Fan On w...
Disable
Disable
276 F
-40F
Float Se...
Neutral ...
Wheel Sp...
Disable
6,902 gal
260 hr

Figure 63 Template Editor

1. Open the template whose default values are to be modified.

2. In the parameter list on the right side of the Template Editor window, locate the parameter whose value

is to be modified.

3. In the Value column, specify the new value for the parameter. There are two types of parameter values:

*  Drop-down (See Changing a Drop-down Value, page 50)

*  Numerical (See Changing a Numerical Value, page 51)

0000414154
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VEHICLE TRIP REPORT

VEHICLE TRIP REPORT

The Vehicle Trip Report is used to view vehicle data during a trip.

NOTE - Vehicle Trip Report and Vehicle Events are intended for use with MaxxForce® 11, 13, and 15 liter
engines only.

To view this window, select SESSIONS > VEHICLE TRIP REPORT in the menu bar.

ACTIVITY REPORT TAB

2 3

\

Driver Info Activity Report (MaxxForce 11/13/15) |\ehidle Events (MaxxForce 11/13/15) | Trip Data | Total Data | System Operation Mor/or |
\ Activity Report
Driver ID
o o Driver ID VIN 1SIMENGENVINIGENG
Customer Name: Software Identification 466HM2U8
Date Printed 01/30/2017 16:52:36 CST
Vehide Info | Trip Information \ Total Information
IYIN = Distance 26,505,900.4 miles Distance 254,695.7 miles
e Fuel Used 86,667,813.2gal Fuel Used 98,435,069.7 gal
Serial Number 466HM2U3000000] Average Fuel E 0.31 e it Ernroa 0.00
N 1SIMENGENVINI6ENG L5 LU AL - Lo i el o
|{onsc wumper Engine Run Time 411,041.7 Engine Run Time 103,079,215.0
| T INT| Average Speed -8.6mph Average Speed 0.0 mph
Software Identification 466HM2U8)
Model 570g451£51Y) Driving Fuel Used 6,847,914.86 gal | | Driving Fuel Used -40,219,952.92 gal
Trip Data Reset Date 00000000 Driving Fuel Economy 3.86mpg Driving Fuel Economy 0.00 mpg
Driving Time -620,192.55 hr Driving Time -2,546,991.95 hr
1 PercentDriving Time ~ -150.8 % Percent Driving Time 546.9 %
Instructions [
Idle Time 0.0hr | | Ide Time 984,129.47 hr
Instructions [tk Percent Idee Time 0.0% | | Percent Ide Time 2113%
s = Idle Fuel Used 0gal Idle Fuel Used 100,288,504.3 gal
Activity Report b
® Activity Report and Vehicle Events are intended for use with ~ = = e = = i e
< . ximum Engine ximum Engine
2010 and later MaxxForce 11/13/15L engines only. 202
®Driver ID and Customer Name data may be added to the 1= Flord Breh® Courit Hend ovabe Cot
" R b uall.' gy Driver Info tzb Fan On Time 107,374,182.3hr | | Engine Overspeed Count
ctivity Report by manually entering it in the Driver Info tal Yk o et
aboxl'e. . o . — Vehide Overspeed 2 Count
© Trip Data/Information represents activity since the last time
:h_f_ maII) ga!a _‘;:fs Teset. ity Ak for s te G PTO Time 1,031,234.30 hr PTO Time 1,097,184.49 hr
otal Data/Information represents activity data for the life o Percent PTO Time 250 % Percent PTO Time 25.6%
the vehicle. 3 PTO Fuel Used 79,819,898.37gal | | PTO Fuel Used 38,366,518.3 64l
®Data available from 2010 and later MaxxForce 11/13/15L
an}Q:;es h:s gcrea;ed»as new :;i:e ;oﬁwa{e x'q;xons are AciveRegenCount 11,073 P 44,028
introduced. Data t at s not available from a specific engine Renen T 608,453.70 hr — 1,192,487.23hr
version will say Not Available in the report. . Regen Fuel Used -1,640.60 pounds | | Regen Fuel Used -3,207.86 pounds
®To reset the trip data, either click on the “Reset Trip
Report” button in the lower right corner of the screen or 4 ResetTrip Report
select “Tools/Reset Trin Renart” from the Menu har /

/

4

0000414102

1. Activity Report Tab 3. Total Trip Information
2. Current Trip Information 4. Reset Trip Report

Figure 64 Activity Report
The Activity Report tab (Figure 64, ltem 1) shows a table of trip information for a single trip or for the life of
the vehicle in an easy-to-print format.
* The column on the left (Figure 64, Iltem 2) displays current trip information.
*  The column on the right (Figure 64, ltem 3) displays total trip information.

» Click Reset Trip Report (Figure 64, ltem 4) to reset vehicle trip report.
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VEHICLE EVENTS TAB

1

\

above.

©Trip Data/Information represents activity since the last time

the trip data was reset.

#Total Data/Information represents activity data for the life of
the vehicle.

#Data available from 2010 and later MaxxForce 11/13/15L
engines has increased as new engine software versions are
introduced. Data that is not available from a specific engine -

Driver Info [ Activity Report (MaxxForce 11/13/15) | Vehide Events (MaxxForce 11/13/15) | Trip Data | Total Data | System Operation Monitor
Driver ID
Customer Name
Vehide Info | [VIN: 1SIMENGENVINIGENG Date Printed:01/31/2017 08:44:12 CST]|
Trame == | [ ion > mph/s [Highest values [Most Recent Events
Serial Number 366203000000 || L oF events: 0 Jvave [units]date [tme Jvoe [unitsfdate
:::: Namber LSTHENGENVINT GENG| [Vehide Speed > 1.76 mph [Highest values [Most Recent Events
Make || [ [# of events: 0 Jvalue Junits[date [tme  value  Junits]
I Software Identification |  466HM2U8| ]Veh'deSpeed e ]W'QS‘ e IMostR e
Model 570g451£SIM 24 ocent ven
Trip Data Reset Date 00000000|| || [#of events: 0 |value Junits]date Jtme  |vae [units[date
[Engine Speed > 2,350 RPM [righest values [Most Recent Events
Instructions | [# of events: 0 |value  Junits[date Jtme  |value  Junits|date
Instructions [tk [coolant Temp. > F [righest values [Most Recent Events
R |# of events: 0 Jvalue  Junits[date Jtme  |value Junits|date
ctivity Report =
® Activity Report and Vehicle Events are intended for use with [oi Temperature > 127F [righest values [Most Recent Events
2010 and later MaxxForce 11/13/15L engines only. El || [# of events: 0 |value Junits[date Jtme  fvale [units[date
®Driver ID and Customer Name data may be added to the L3
Activity Report by manually entering it in the Driver Info tab {:’:f:::‘;e iv'md = Vm[m = I’V”:;Re“i::i‘:;

<

1. Vehicle Events Tab

/

2

2. Reset VETS Button
Figure 65 Vehicle Events

Reset VETS

0000414110

The Vehicle Events tab (Figure 65, Item 1) shows a chart of high values and recent values of vehicle events
and how for long the event occurred.

To reset vehicle events, click the RESET VETS button. (Figure 65, Item 2)
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VIEW TRIP DATA

1

\

2

/

e Total Data/Information represents activity data for the life of
the vehicle.

#Data available from 2010 and later MaxxForce 11/13/15L
engines has increased as new engine software versions are
introduced. Data that is not available from a specific engine <

Driver Info | Activity Report (MaxxForce 11/13/15) | Vehicle Events (Ma\\Force 11/13/15) | Trip Data | Total Data | System Operation Monitor
| save |
Driver 0 | -
T[> [Name Value |units
Customer Name| ‘ 58251|AESC Mode 4 Trip Engine Hours 435,902.71|hr
S8001|AESC Mode 4 Trip Fuel Used 4,693,942.6|gal
- 58261|AESC Mode S Trip Engine Hours 561,875.16/hr
Vehide Info | S8011|AESC Mode 5 Trip Fuel Used 106,315, 325.1|gal
£ 58271|AESC Mode 6 Trip Engine Hours 228,469.32/hr =
YlName Value l 58021|AESC Mode 6 Trip Fuel Used 17,233,805.4|gal
Serial Number 466HM2U : 58221|ECM trip Time 567,792.81}hr
J[VIN 151mgmvm15m(ﬂ 58231|Engine Trip Time 377,933.59hr
[Unit Number 83472|Total Engine Over Speed 3,87SRPM =
Maxe INT 83192|Trip AESC Device 1 Fuel Used 35,721, 522.9|gal
166EM2US| 83212|Trip AESC Device 2 Fuel Used 85,349, 959.1/gal
Model 570451£51M 23232[Trip AESC Device 3 Fuel Used 36,506, 288.0/gal
Trip Data Reset Date 0 58031|Trip AESC Fuel Used 101,340, 320.8|gal
II -{ 59501 AESC Mobile Distance 20,993.73miles
83182|Trip AESC Stationary Time 403,237.27hr
Instructions ‘ 58041|Trip Average Engine Load -2,284.3|1b-ft
58061|Trip Average Engine Power 13,918, 608.73)hp
Instructions ¥tox 58051|Trip Average Engine Speed 26,588|RPM
58161|Trip Average Fuel Rate 40.84/gal/hr
Activity Report Ja 83383|Trip Average Vehicle Speed 322.36/mph
@ Activity Report and Vehicle Events are intended for use with 59001|Trip Coast Distance 1,329,313.63|miles
2010 and later MaxxForce 11/13/15L engines only = 59151|Trip Coast Fuel Used 57,509,301.8|gal
) g B 59281|Trip Coast Time 87,537.68/hr
Driver ID and Customer Name data may be added to the 59011|Trip Cruise Control Distance 1,071,431.82/miles
Activity Report by manually entering it in the Driver Info tab 59161|Trip Cruise Control Fuel Used 35,826,130.2|gal
above. 59291|Trip Cruise Control Time 192,218.96/hr
o Trip Data/Information represents activity since the last time :::21 ;I?P g‘?"e ;‘:eiage dmﬂ Economy 7T ::S 3:“‘1’3
the trip data was reset. fip Drive Tuel Do e S

Trip AESC Mobile Distance Note: AESC is replacing PTO and ATC(Auxiliary Throttle Control)

Save button

2. Trip Data tab

Figure 66 Trip Data

The Trip Data tab (Figure 66, Item 1) shows a list of vehicle trip data since the trip was last reset.

Select any item in the list to view a description of that item below.

Click the SAVE button to save current vehicle trip information. (Figure 66, Item 2)
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VEHICLE TRIP REPORT

VIEW TOTAL DATA

1

\

/2

Activity Report

® Activity Report and Vehicle Events are intended for use with
2010 and later MaxxForce 11/13/15L engines only.

#Driver ID and Customer Name data may be added to the
Activity Report by manually entering it in the Driver Info tab
above.

#Trip Data/Information represents activity since the last time
the trip data was reset.

#Total Data/Information represents activity data for the life of
the vehicle.

#Data available from 2010 and later MaxxForce 11/13/15L
engines has increased as new engine software versions are
introduced. Data that is not available from a specific engine

version will sav Not Availahle in the renart

m

99,465, 615.1|gal

57361|Total SC Stationary Fuel Used

24,326,798.5/gal

AE:!
AE!
57181|Total AESC Mode 6 Fuel Used
AE!
AE!

57381|Total SC Stationary Time

292,831.35/hr

83373|Total Average Vehicle Speed

292.91|mph

57061|Total Coast Distance

19,857.39/miles

57211|Total Coast Fuel Used

112,550, 910.5|gal

57261|Total Coast Time

57001|Total Cruise Control Distance

57221|Total Cruise Control Fuel Used

207, 634.79hr
503,717.15/miles
39,600,438.3|gal

57271|Total Cruise Control Time

32,044.82/hr -

Driver Info | Activity Report (MaxxForce 11/13/15) | Vehide Events (Ma)\Force 11/13/15) [ Trip Data | Total Data | System Operation Monitor |
s | save |
Driver ID|
Customer Name| Y[ [Name i Value | units
23012|Engine On Time 486, 967.95/hr o
83272|Hard Brake Incident Monitor M
veﬁde]nfol 83054|Total A/T Parked Regen Requests 20,551
| 83064|Total A/T Regen Inhibit Reque: 38,712
e e 7| [[FesLazizotel aEsC Fuel Used 29,628,829.6/gal
- )| || S7351|Total AESC Mobile Fuel Used 14,201,719.9gal
IF;““ Number 466HM2 || || 57371/Total AESC Mobile Time 212,967.08hr =
N 1STMENGENVINI6ENG|| ||™57071|Total AESC Mode 1 Engine Hours 242,985.56/hr
|{vnic Number 57131|Total AESC Mode 1 Fuel Used 53,676,559.3|gal
57081[Total AESC Mode 2 Engine Hours 286, 214.26)hr
57141|Total AESC Mode 2 Fuel Used 37,601,977.6/gal
57091|Total AESC Mode 3 Engine Hours 511,401.88/hr
57151 3 Fuel Used 29,437,955.7 gal
57101|Total AESC Mode 4 Engine Hours 57,278.47[hr
57161|Total AESC Mode 4 Fuel Used 68,042,223.4/gal
57111|Total AESC Mode 5 Engine Hours 190,999.52hr
= = 57171|Total AESC Mode 5 Fuel Used 6,015,061.4/gal
Instructions [V]te 57121|Total AESC Mode 6 Engine Hours 581, 785.75)hr

Total AESC Mode 3 Fuel Used Note: AESC is replacing PTO and ATC(Auxiliary Throttle Control)

Save button

2. Total Data tab

Figure 67 Total Data

0000414107

The Total Data tab shows (Figure 67, Iltem 1) a list of vehicle data over the lifetime of the vehicle.

» Select any item in the list to view a description of that item below.

» Click the SAVE button to save trip information for the life of the vehicle. (Figure 67, ltem 2)
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VEHICLE TRIP REPORT

SEARCH TRIP DATA BY KEYWORD(S)

1. In the menu bar, select SESSIONS > VEHICLE TRIP REPORT.

2 3

1\ \ / 4

Driver Info "\ [[Activity Report (MaxxForce 11/13/15) | Vehice Events (MaxxForce 11/13/15) | Trip Data | Total Data | System Operation Monitor| /
v \ T 7/
y
il YD [Name ~ [value uny/”
Cletoner e | 58251/AESC Mode 4 Trip Engine Hours |~ 43s,902. 1/ ~
SB001|AESC Mode 4 Trip Fuel Used ﬁi s f6|gal 7
58261|AESC Mode S Trip Engine Hours o ;'5416 lhr
Vehide Info ‘ 58011|AESC Mode 5 Trip Fuel Used f _iiie 25.1[gal
e 58271|AESC Mode 6 Trip Engine Hours Il ‘ 9.32|hr =
| Name Value 58021|AESC Mode 6 Trip Fuel Used I 105.4/gal
ISelrial Number 466HM2U 58221|ECM trip Time Clear E] Cancel b2.81[hr
Ik‘m 1SIMENGENVINIGENG] 58231|Engine Trip Time Trrres3.59hr
“\'Jni: Number £3472|Total Engine Over Speed 3,875RPM =
[Make INT| 83192(Trip AESC Device 1 Fuel Used 35,721,522.9|gal
Software Identification 266HM2U8 83212[Trip AESC Device 2 Fuel Used 85,349,959.1|gal
IModel 570g451£SIM| 83232[Trip AESC Device 3 Fuel Used 36,506,288.0/gal
Trip Data Reset Date 58031(Trip AESC Fuel Used 101, 340, 320.8|gal
59501 Trip AESC Mobile Distance 20,993.73miles
83182[Trip AESC Stationary Time 403,237.27|hr
Instructions | 58041|Trip Average Engine Load —2,284.3[1b—ft
58061|Trip Average Engine Power 13,918, 608.73|hp
Instructions Lock 58051|Trip Average Engine Speed 26,588RPM
58161|Trip Average Fuel Rate 40.84|gal/hr
Activity Report = 83383|Trip Average Vehicle Speed 322.36|mph
® Activity Report and Vehicle Events are intended for use with ::22; ;’?" g“’z ;’;’:‘gced ;;323'93;;6: mie’
" < = rip Coas el Use R . .8lga
2019 and later MaxxForce 11/13/15L engines only. = 59281[Trip Coast Time 87,537 68)nr
Driver ID and Customer Name data may be added to the 59011|Trip Cruise Control Distance 1,071,431.82/miles
Activity Report by manually entering it in the Driver Info tab 59161|Trip Cruise Control Fuel Used 35,826,130.2|gal
above. 59291(Trip Cruise Control Time 192,218.96/hr
©Trip Data/Information represents activity since the last time $9511 T“}P D“}"e Average Fuel Economy SS8.0impg
the trip data was reset. 59261 Iz%p Dr%ve mel Used 362, 657.21gal <
:hz"v‘:‘m_lc)l:“"’l"f°"““‘°“ represanis actify,data for te ffe of Trip AESC Mobile Distance Note: AESC is replacing PTO and ATC(Auxiliary Throttle Control)

®Data available from 2010 and later MaxxForce 11/13/15L
engines has increased as new engine software versions are
introduced. Data that is not available from a specific engine -

0000414108
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Find icon 3. Total Data tab
2. Trip Data tab 4. Find window

Figure 68 Trip Data
2. Select either the TRIP DATA tab (Figure 68, Item 2) or the TOTAL DATA tab (Figure 68, Item 3).
3. Click the Find icon. (Figure 68, ltem 1)
4. In the Find window (Figure 68, Item 4), enter the keywords to be searched for.
5. Click OK.

NOTE - The searched item(s) will now appear as the first column in the table.
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VEHICLE TRIP REPORT

PRINTING VEHICLE TRIP REPORTS

i% Trip Report...

Figure 69 Trip Report Icon

1. There are two ways to print a vehicle trip report:

*  Click the Trip Report Icon in the Toolbar.
* In the menu bar, select FILE > PRINT > TRIP REPORT.

Print range
@ Al
() Pages from: 1

Selection

Type: Xerox WorkCentre 7535 PS
Where:  Woodridge Training Center
Comment: Far end near lunch room - Xerox WorkCentre 753! ] Print to file

(&) Print =)
Printer
Name:  [\WcsvwO1\wtc35 v [ Propeties.. |
Status:  Ready

Copies

Number of copies: 1 =

3 3 Collate
128 )2

Lok J[ cancel |

2. Select the desired printer.

3. Click OK.

0000414106

Figure 70 Print Options
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VEHICLE TRIP REPORT

RESETTING THE VEHICLE TRIP REPORT

A Trip Report is the time between vehicle trip resets.

|Tools
‘_, Activate Com Link F6
Select Com Link 4
Simulate Engine »
§,‘~ Snapshot Trigger Setup...
O Arm Snapshot Trigger

Start Recording Snapshot

é

Snapshot Recording Interval »

Clear Statistics

’L'l.}

Reset Trip Report
Reset VETS

0000414181

Figure 71 Tools Menu
To start a new trip report, select TOOLS > RESET TRIP REPORT in the menu bar.
Alternately, reset the report from within a trip report session:
1. In the menu bar, select SESSIONS > VEHICLE TRIP REPORT.

2. Click the RESET TRIP REPORT button.
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PRINTING

PRINTING

Vehicle information can be printed or exported by selecting the appropriate options in the File menu.

Online Mode

Open Snapshot Recording File...

Export Parameters...

Create Template...

Open Template...

Print » Vehicle...

& O\

Export Vehicle Data...

Update DB

TripR
Revert DB Dp Beport

Export Trip Data
Exit

Figure 72 Print Options
VEHICLE INFORMATION
Use this procedure to print vehicle information.
1. In the menu bar, select FILE > PRINT > VEHICLE.
2. Select the desired printer.
3. Click OK.
EXPORT VEHICLE DATA
Use this procedure to export vehicle information to a .txt file.
1. In the menu bar, select FILE > PRINT > EXPORT VEHICLE DATA.
2. Select the folder in which to save the data.
3. Click SAVE.
TRIP REPORT
Use this procedure to print vehicle activity report..
1. In the menu bar, select FILE > PRINT > TRIP REPORT.
2. Select the desired printer.

3. Click OK.

Ctrl+F1

0000414104
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